Letter of Transmittal
The content of this manual is about using the program called TunerPro RT to change different
parameters inside a Buell ECM. TunerPro RT can be used on any fuel injected Buell made from 1999 to
2010. With this program, tuning possibilities for Buell owners are endless. TunerPro RT is a very
powerful program, but is also free. This makes for an easy to access program that can perform any
function the Buell enthusiast might want to perform to the Buell ECM. In this manual, the steps that are
taken from the very beginning of the tuning process to the more advanced processes such as
datalogging are discussed in detail. With this manual guiding you along the tuning process every step of
the way, you have no fear of missing a step.
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Preface
The purpose of this document is to inform readers on how to change information related to
performance in the ECM (Electronic Control Module) of their 1999-2010 Buell motorcycle using a
computer program called TunerPro RT. Because TunerPro RT is a vast and powerful program, there is
definitely an overwhelming feeling when the program is viewed for the first time. By having this guide,
Buell owners can now change the information within the ECM without having to worry about getting
lost in the process.
Myself, like most other people, am a hands-on, visual type of learner. If I can’t see it or touch it, then I
probably will not learn things to my full potential. This was what scared me the most about changing
information within my Buell ECM. I couldn’t put my own two hands on the ECMs information, I could
only punch keys on a keyboard to manipulate it. By having someone go through the process before you
do, the level of stress is decreased dramatically. This document is all about that idea. I have created this
guide, with the help and resources of many others, from the very first step of downloading TunerPro RT
to datalogging with the bike to see if the changes made a difference.
By far, using TunerPro RT is not the only way to change the information within the Buell ECM. Other
various tuning programs can also perform this function. Some replacement ECMs are a “Race” version
that should yield better performance. There are also fuel interceptors that can add or subtract fuel to
the bike after the ECM performed all of its calculations. In my mind though, the best option was
TunerPro RT because of how powerful the program is. Plus, the 2008-2010 Buell DDFI 3 ECMs have
different programming than the first 2 versions (DDFI 1 and DDFI 2). The popular previous programs that
could tune the first 2 versions can’t be used on the DDFI 3 ECM based on those different programming
changes.
This document will go through the whole tuning process, from start to finish, from downloading
TunerPro RT to changing the information within the ECM. The document will also focus on other
programs that can be used with TunerPro RT to maximize performance further, such as the XPR Fuel
Map Extractor and the MegaLog Viewer program. This document will even focus on explaining the
differences between the files needed for TunerPro RT to work with the Buell ECMs.
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Disclaimer
By following this guide, you assume total responsibility. In no way am I,
Jared Zuech, responsible to any damage that can occur to you, your
property, or your motorcycle. By following this guide, you assume all
associated risks that are accompanied with tuning.
IF YOU ARE UNSURE ABOUT WHAT HAS BEEN SAID SO FAR OR DO NOT
FEEL 100% SURE OF WHAT YOU ARE ABOUT TO DO, THEN DO NOT
CONTINUE ANY FURTHER.
Ask a qualified person to perform the work for you. Modifying the ECM
will render your warranty invalid, could harm your engine, and is
performed entirely at your own risk. Again, in no way am I, Jared Zuech,
responsible for any damage that can occur to yourself, your property,
or your motorcycle.
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Introduction to the Buell ECU
What Sensors are involved?
There are various sensor values that the Buell ECM needs to know in order to supply the right amount of
fuel to the engine: the Throttle Position Sensor (TPS), the Adaptive Fuel Value (AFV), and the Oxygen
Sensor (o2 Sensor), Engine temperature (Engine Temp.), Inlet Air Temperature (IAT), Crankshaft Position
Sensor (CKP), and the Bank Angle Sensor (BAS). Rather than restate information that is readily available
to Buell owners already, the first 2 sensors are from the ECMspy©5 instruction manual titled “Buell
Tuning Guide v. 1.7.8”. These are very well thought-out descriptions for what the sensors do. From the
Buell Tuning Guide v. 1.7.8 (2007):

Throttle Position Sensor (TPS)
“The TPS is the Throttle Position Sensor. The ECM needs to know how open the throttle is, and in
conjunction with the RPM, and atmospheric conditions, it knows how much air is flowing and hence how
much fuel to inject.

Adaptive Fuel Value (AFV)
The Adaptive Fuel Value is how the Buell automatically compensates for changes to the environment . . .
[such as] riding up mountains, or swapping the exhaust silencer. It is not perfect, but does a good job to
compensate for minor changes” (p. 14).

Oxygen Sensor (o2 Sensor)
The ECM monitors how much oxygen is coming out of the motor through the exhaust. By monitoring
how much oxygen is coming out of the motor, the sensor changes its resistance, which can be read by
the ECM. Having too much oxygen in the exhaust is a lean condition (low fuel content), while too little
oxygen is a rich condition (high fuel content). The middle reading between rich and lean is an air-fuel
value of 14.7:1, which is 14.7 parts of fuel to 1 part of air. This is called the Stoichiometric value.

Engine Temperature Sensor (Engine Temp.)
This sensor is also used to determine how much fuel the engine receives from the ECM. If the engine is
cold, then more fuel will be added to ensure the engine keeps running. When the engine warms up, less
fuel is needed to keep it running.

Inlet Air Temperature Sensor (IAT)
The IAT will determine the temperature of the air entering the engine. A well-known principle is that
cold air is denser than warm air. The ECM needs to know this information in order to ensure the engine
operates at peak performance.
5

ECMspy is a Copyrighted business and computer program. All rights reserved.
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Crankshaft Position Sensor (CKP)
The CKP is used by the ECM to know when to perform many tasks, such as fire the ignition coil and inject
fuel into the combustion chamber. Many other functions within the ECM rely on this sensor also, such as
detecting a cylinder misfire.

Bank Angle Sensor (BAS)
This sensor sends information to the ECM regarding the angle that the motorcycle is leaning. The BAS is
used as a safety tool as well. If the bike were to tip over, the BAS would send the data to the ECM, then
the ECM would cut fueling and ignition spark to shut off the engine. This would prevent a spark if there
were a fuel spill or prevent the bike from causing further damage by the engine still running.
NOTE: If the bike is still running lean, then there is something else wrong besides the ECM tables. A very
common cause of the bike running lean is either a bad Inlet Air Temperature (IAT) sensor or a bad o2
sensor.

How the ECM Interprets the Signals from Sensors
The Buell Tuning Guide v. 1.7.8 (2007) states: “When the bike is ridden in Closed Loop mode (explained
next) the ECM monitors the O2 sensor and learns the appropriate AFV value to apply to the fuel maps.
This AFV value is applied across the entire fuel map range. . . AFV values can vary from 80 to 160% but
should be kept between 90 and 110% whenever possible” (p. 14).

What is Closed Loop?
The Buell Tuning Guide v. 1.7.8 (2007) states: “The Closed Loop area is found when riding in low throttle
positions at low rpm, but not under stress. I believe this is approximately 1500-4000rpm and 10 – 30%
throttle.
Riding in Closed Loop allows the ECM to reset the AFV and compensate for the environment. It is good
practice to do this periodically. Normal riding conditions will normally include Closed Loop riding for long
enough. To ensure the AFV is about right for your setup, try and do a few miles on flat roads between 40
– 70mph and low throttle openings, with a steady throttle” (p. 14).

What does this all mean?
Since the ECM checks all of the signals and inputs from all of the sensors, it is theoretically impossible for
the engine to run too lean and cause permanent damage. The ECM compares the o2 sensor reading with
the AFV reading and then adjusts the map accordingly. If the o2 sensor is reading outside of their
operating zone between rich and lean, then the whole map is adjusted. For example, if the o2 sensor is
reading lean and the AFV is showing that it is trying to add fuel (trying to become rich), then the whole
map will increase by a percentage (global increase).
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Introduction to TunerPro RT
Various Vehicles that TunerPro RT can be used on
Since TunerPro RT is such a powerful program, there is no surprise that it is becoming very useful to
other vehicles than it had intended to be. For instance, here is an excerpt from Mark Mansur, the
developer and inventor of TunerPro:
“TunerPro started life in early March of 2003 and was originally created to tune GM vehicles between
model years 1985 and 1995. TunerPro has since grown into a very robust tuning tool and is evolving
faster than ever. This project started as an educational project with a few simple goals: It should be
available for free in its essence, it should be better than what is available in its class, it should remain as
simple as possible to use, and it should be fun for me to develop. . . TunerPro supports many vehicle
makes and models, including GM OBDI (pre-96) [1985-1995], Ford EECIV and EECV, early and mid-90's
Nissan, DSM (Mitsubishi), Buell, BMW, Porsche, Renault (Fenix 1 and 3), and . . . I'm currently aware of
users experimenting with Volkswagen, Ducati, Subaru, and more” (2011).6

Why TunerPro RT was Chosen
I chose TunerPro RT for tuning my Buell because it was a relatively new program to the Buell world and
there was no step-by-step guide from beginning to end to help people along the way. Plus, I was kind of
forced between a rock and a hard place. Since my Buell motorcycle is a 2008 with the DDFI 3, ECMspy
will not work on my bike (for the most part). For a little bit of history, ECMspy used to be the only way to
tune a stock ECM, rather than buying a completely new race ECM or adding a fuel controller, which is
not as precise as tuning an ECM to suit your exact needs. If that route was chosen, the motorcycle would
not perform as good as a tuned ECM to suit its riding conditions.
When TunerPro RT was introduced into the Buell world, and it took off like wildfire. This program could
read the ECM, write to the ECM, change the ECM fuel tables, and datalog all in one program. Before,
one had to use ECMread for reading and writing to the ECM. In order to change the ECM fuel tables and
datalog, ECMspy had to be used. By having a program that can do everything in one, there is much less
frustration with issues related to transferring files to and from different programs.
Another reason why TunerPro RT was chosen was based on its learning curve. Granted, everyone has a
different level of learning, but TunerPro RT looks past that. Since all of the maps in the Buell ECU are in
table form, the tables extracted from the ECM into TunerPro can then be copied and pasted into any
spreadsheet program, such as Microsoft©7 Excel or LibreOffice©8.

6

If you would like to learn more about what vehicles are supported by TunerPro RT, go to www.tunerpro.net for
more details.
7
Microsoft is a Copyrighted business. All rights reserved.
8
LibreOffice is a Copyrighted program. All rights reserved.
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Where to get TunerPro RT
TunerPro RT is a free program that can be downloaded from http://tunerpro.net/downloadApp.htm.
TunerPro is the base application, and TunerPro RT is the full version. The only difference between the
two is that TunerPro RT has a “nag” window that disappears after 10 seconds after startup wanting to
be registered, like in Figure 1 below:

Figure 1: Registration Pop-up

There is no penalty against not registering the program, just a pop-up window that wants to be
registered. In order to work with the Buell ECMs, a plugin will also be needed. This can be found at
http://tunerpro.net/downloadPlugins.html and is called BuellIOPlugin.zip.

TunerPro RT Interface
This section will discuss the various buttons and commands of TunerPro RT that are used for Buell ECMs.
Granted, there are more buttons in the program that will not be used in this application, but only the
ones needed for Buell motorcycles will be discussed.

Buttons/Functions used in TunerPro RT
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Figure 2: Top-Left of TunerPro RT (Jared Zuech

3

5

In Figure 2:
1. (From left to right) This section is for Opening, Saving, and Closing bin files. These buttons are
shortcuts that do the same operation as selecting the drop-down menu titled “File”.
NOTE: Clicking “save BIN” does not save the .bin file to the ECM. It only saves the .bin to the
TunerPro RT file. This will not save the changes made to the ECM.
2. (From left to right) This section is for Selecting, Saving, and Creating XDF files. These are shortcut
buttons that do the same function as selecting the drop-down menu titled “XDF”.
3. The only button in this section is called “Initialized Emulation Hardware”. It is used for
connecting the Buell ECM to a laptop when the XDF file is loaded.
4. This is the very top row of TunerPro RT. (From left to right) File, XDF, View, Compare,
Acquisition, Tools, Window, and Help are the different drop-down menus.
a. “File” is used for opening, closing, and saving bins within TunerPro RT. It is also used for
exiting TunerPro RT.
b. “XDF” is used for selecting, opening, and saving XDF files as well as viewing XDF file
information.
c. “View” is for choosing which toolbars are up at the top of the screen as well as opening
up various parameter tools.
d. “Compare” is used for comparing .bin files against one another.
e. “Acquisition” is used for data acquisition (datalogging) as well as manipulating the
datalog files, such as playback speed, loading, closing, and exporting log files. It is also
used for showing a virtual dash, data lists, history tables, and monitors.
NOTE: The virtual dash feature and history tables will only work with Xoptiinside’s ADX
file. The virtual dash and history table features will not work with the ECMspy ADX files.
f.

“Tools” is used for initializing and releasing emulation hardware (XDF files) as well as
setting up TunerPro RT initially through the “Preferences” option.
g. “Window” is used for arranging the program style as well as saving all or closing all open
tables/windows.
h. “Help” is used for finding various help topics with assistance in using TunerPro RT. This
can be a valuable asset for a beginner, but beware of the complex terms used in the
explanations.
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5. (From left to right) Upload Current Bin to Emulator, Download Bin from Emulator to TunerPro.
The two icons on the right of the up and down arrows are not used for this application. Only the
up and down arrows are used for Buell ECMs.
1

2

Figure 3: Top-middle side of TunerPro RT

In Figure 3:
1. (From left to right) This section is used for editing ADX files, data acquisition
(connect/disconnect), and enabling/disabling data tracing.
2. (From left to right) This section is used for showing data dash, showing data list views, showing
data history tables, and showing data monitors. These can also be performed by using the
“Acquisition” drop-down menu in the top-left corner of TunerPro RT.

Figure 4: Top-right hand side of TunerPro RT

In Figure 4:
The upper-right hand side of TunerPro RT is used for datalog files. (From left to right) There is Record
new log, Play log, Pause log, Stop log, and Select a log. The slider bar on the far right is used for scrolling
through the duration of the log and is infinitely adjustable.

Figure 5: Bottom left of TunerPro RT

In Figure 5:
From left to right, the status bars are Emulation status, Hardware information, ECM status bar, and Data
Acquisition status.

TunerPro RT Initial Setup
This section will describe the differences between each file type used in TunerPro RT as well as how to
initially setup the program.
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Differences between XDF, XDF Lite, ADX, and BIN Files
The following information was gathered during a phone call with Mike Cobb on October 31, 2012:
XDF File: “This file is characterized by an ending of “.xdf” and is basically an index of the ECM. TunerPro
RT used the XDF file to both gather the information off of the ECM and send information to the ECM.
XDF Lite: This file type can only be found on Xoptiinside’s website at www.xoptiinside.com. The Lite
version includes everything that is needed to tune the Buell ECM and nothing else. Unlike the regular
XDF file, the Lite does not include other functions that are used on other vehicles besides Buell
motorcycles. The Lite file makes takes away some of the overwhelming feeling that the regular XDF file
can sometimes cause with all of its functions.
ADX File: This file is characterized by an ending of “.adx” and is an index of the live data that the ECM is
seeing. This live data includes various voltages and readings that the bike’s sensors are sending to the
ECM. While the bike is running, the ADX file can record and time-stamp the information that was
gathered by the ECM. This data log can then be saved and played back which can give some valuable
information on the performance of the bike.
BIN File: This file ends with the file name of “.bin” and is the information stored inside the ECM. This
information can range from the amount of fuel the engine receives at a given RPM and TPS or the AFV
parameters. When the topic of tuning an ECM comes up, these are the parameters that are changed to
gain better performance from a vehicle (2012, October 31).

NOTE: Before proceeding any further, make sure to have downloaded TunerPro RT as well as the Buell
IO Plugin. For more information, see the heading titled “Where to get TunerPro RT.”

NOTE: Whenever this symbol appears: -> it means that there is a path to a file. The last part after the
symbol is the destination folder.

Initial Setup of TunerPro RT
All of the graphics in this section are from Mike Cobb’s PDF guide titled “Using TunerPro RT” unless
stated otherwise. From Xoptiinside’s “Using TunerPro RT”:
1. “Make sure to have downloaded both the program (TunerPro RT) as well as the plugin for Buells
(BuellIOPlugin.zip).
2. Unzip the plugin and place it within the TunerPro folder within your documents. TunerPro ->
Plugins
3. To set up TunerPro RT for the first use:
a. Make sure to have the ECM transfer cable and the cable driver installed on the laptop.
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b. Open TunerPro RT and click “Tools” from the drop-down menu, then select
“Preferences” at the bottom of the Tools menu, which should look like Figure 6 below:

Figure 6: TunerPro RT Preferences Window

c. Click on the tab titled “Data Acq./Emulation.” On the left hand side of the pop-up box,
click on the drop-down menu “Use Plug-In” and select “TunerPro Data Acqu I/O.”
d. Now click “Configure Plug-in Component,” which should look like Figure 7 below:

Figure 7: Configure Plug-In Component (Jared Zuech)
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e. Since your ECM transfer cable is plugged in to the laptop, use the device manager on the
laptop to find which COM port the cable is on.
NOTE: Make sure to plug in the ECM transfer cable in to the same USB port each time you use TunerPro.
Otherwise, the COM port will have to be changed each time TunerPro is used. Your COM port number
may be different than the example given.

f.

You can now close the “Data Acquisition Cable” and “Data Acquisition Plug-In
Configuration” windows. Now, on the left-hand side of the Data Acq./Emulation tab of
the “Preferences” window which is still open, select the “Emulation Plug-In Component”
drop-down menu and switch to Buell EEPROM reader/writer.
g. Now click the “General” tab, which has 4 selection spaces. Make sure that:
i. In the top left, all boxes are checked.
ii. In the bottom left, select: XDF, ADX, BIN
iii. In the top right, select: Diff. (edit-compare) and check the two boxes titled
“color table cells” and “reverse columns.”
The “Preferences” window should resemble the figure below (Figure 8):

Figure 8: Preferences Window Example (Xoptiinside)
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iv. Click Apply, and then click OK.
4. Click the “View” drop-down menu at the top of TunerPro RT, and then click “Toolbars” with the
right-facing arrow next to it. Then select the following views:
a. Basic
b. Tools
c. RT
d. Emulation
e. Data Acquisition
f. Data Acquisition Log
g. Data Acquisition Send Command
Figure 9 shows what the View -> Toolbars checklist should look like:

Figure 9: View -> Toolbars Checklist (Xoptiinside)

5. The next part requires that the ECM transfer cable is connected to both the laptop and the ECM.
6. After the cable is connected, turn the key on and the Ignition switch to the “Run” position.
a. If the bike did not auto-connect then select the gray cable at the top of TunerPro RT
(titled “Initialize Emulation Hardware,” also in Figure 1).
b. If the laptop speakers are on, it will beep when connected.
c. In the lower left corner of the screen (See Figure 4), where originally there was the
statement “Hardware not found,” will be “Initializing.” Once completed, your Buell ECM
firmware type will show up in the same box.
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7. The first 5 characters in the hardware section in the lower-left of TunerPro RT is the firmware
type of the Buell ECM. Remember these first 5 characters, as these are needed for determining
which XDF and ADX files TunerPro RT needs. Figure 10 below is a good reference that will help
to determine which Firmware your bike has. This is a general guideline as some ECMs may be
different Firmware versions from year to year.

Figure 10: Buell year and Firmware table (ECMspy)

a. Go to http://www.xoptiinside.com/tuning_programs__xdf_-_adx__other_files to
download the correct XDF and ADX files. You should have the following 4 files:
i. XDF (link to ECMspy’s website)
ii. XDF Lite
iii. ADX (link to ECMspy’s website)
iv. DDFI (1,2 or 3) ADX with live data, data dash, tps reset, etc.
b. When you have downloaded all 4 files, move them into the Documents -> TunerPro
Files -> Bin Definitions
8. Open TunerPro RT, if it is not already open.
a. Select XDF from the drop-down menu at the top of the screen, then click “Select XDF”
from the menu.
b. When the browse window appears, select either the full XDF or the Lite XDF
(recommended). It will be in the Documents -> TunerPro Files -> Bin Definitions
folder.

NOTE: Each time TunerPro RT is opened, it will automatically load the last XDF, ADX, and BIN files from
the last time TunerPro RT was used.

c. Now select “Acquisition” from the drop-down menu at the top of TunerPro RT, then
click the “Load Definition File” option. This will bring up a browse window. Go to
Documents -> TunerPro Files -> Bin Definitions. This will bring up the two ADX files
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that were downloaded earlier. Select either Xoptiinside’s ADX with the live data dash,
tps reset, and diagnostic codes (recommended) or ECMspy’s ADX file.
Now TunerPro RT is ready to read from, write to, and datalog with the Buell ECM” (p. 1-6).

How TunerPro RT Remembers Recently Loaded Files
TunerPro RT will remember the last BIN, ADX, and XDF files that were recently loaded. Even if the
program is closed and opened up again, the previous files loaded to TunerPro RT will still be in the
program.

Datalogging with TunerPro RT
The following section will demonstrate the correct processes to acquire data from the motorcycle while
riding.

Data Acquisition Setup
From Mike Cobb’s “Using TunerPro RT” PDF guide:
“In order to datalog, see the live data dash, reset the TPS, run diagnostics, and read and clear trouble
codes, an ADX file has to be loaded to TunerPro RT.
1. From the drop-down menu at the top of the screen in TunerPro RT, select “Tools”, and then click
the “Release Emulation Hardware” button.
a. The status bar at the bottom of the screen in TunerPro RT (where the Firmware type is
located) should now state “Hardware Not Found”.
2. To load the ADX file, select from the drop-down menu “Acquisition”, and then select “Load
Definition File”. This will display a pop-up menu for choosing which ADX file to load. Since the 2
ADX files were moved to the TunerPro Files folder in the Documents section of the laptop, select
Xoptiinside’s ADX file, then click OK to load the file.
3. With the ADX file now loaded, make sure the ECM transfer cable is connected to both the laptop
and ECM, along with the bikes key and ignition switch in the on position, click the button that
has the two blue horizontal arrows facing opposite of each other (Acquire Data
Connect/Disconnect button) at the top of TunerPro RT.
a. The Data Acquisition status bar at the bottom of the screen in TunerPro RT should turn
from a yellow box saying “Not Connected” to a blue box showing “Connected”” (p. 6-7).
NOTE: If the yellow box does not appear blue saying “Connected” and either stays with a pink box saying
“Connecting” or a flashing blue and red box, then see the section under “Troubleshooting” titled
“Dropped Connection with Data Acquisition.”
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How to Record and Play back Datalog Files
From Xoptiinside’s “Using TunerPro RT” PDF guide:
1. “In order to datalog with TunerPro RT, make sure the previous section was completed titled
“Data Acquisition Setup”. With the ECM transfer cable connected between the laptop and Buell
ECM and the bikes key and ignition switch in the ON position, select “Acquisition” from the
drop-down menu at the top of TunerPro RT and then select “Record”.
2. To stop a datalog session, select “Acquisition” from the drop-down menu at the top of TunerPro
RT and select “Stop”.
a. This will cause a pop-up window to appear prompting a name for the datalog file. Insert
a name for the file and click “Save”.
3. To play back a datalog file, select “Acquisition” from the drop-down menu at the top of
TunerPro RT and select “Play”. You can now move through the items you want to see or setup,
such as the data dash, List items, history tables, and data monitors at the top-center of the
toolbar” (p. 7). For more information, see Figure 2, icon number 2.
NOTE: These items are fully adjustable under the “Edit Definition” menu in the “Acquisition” drop-down
menu at the top of TunerPro RT. “Edit Definition” is editing the ADX file and can be customized to match
your ECM and needs.

NOTE: To return to the Read/Write side of TunerPro RT, select the two opposing facing arrows (Acquire
Data Connect/Disconnect) at the top of TunerPro RT to disconnect from the ADX file. Now click on the
gray plug (Initialize Emulation Hardware) at the top of TunerPro RT to connect to the Read/Write side.”

How to Ride during Datalogging Sessions
During a datalogging session, ride as you would normally. By riding as you would normally, the datalog
file can gather the riding situations that are most pertinent to your bike. During datalogging, the datalog
file will gather all of the information that the ECM is seeing. After you have saved the datalog file, you
can then play it back to see exactly what information the ECM was seeing during the ride.
Make sure to get as many throttle positions in as possible as well as different engine speeds within each
gear. Make the datalog run at least 20 minutes long since the ECM takes around 15 minutes to adjust to
the information that the AFV and o2 sensors are sending to the ECM. The longer the datalogging run,
the better the information will be. By riding a longer duration, the datalog file can show the warm-up
time of the bike, the fuel enrichment cycle, and how the engine performs at operating temperature.
Make sure to start the datalogging session with a cold engine, which is where the bike has not been
running recently. This way the datalog file can gather the warm-up cycle to see if drivability can be
improved.
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Using History Tables to your Advantage
When a datalog file has been created and saved, the History Tables function is the best bet for providing
adequate data for properly tuning your motorcycle. The History Tables can display how much fuel the
ECM is adding or subtracting to the base fuel maps based on the feedback from the o2 sensor(s). This
can tell you whether the bike is running rich or lean based on if the values in the history table are
positive or negative.
NOTE: These values within the History Tables are based on percentages, not actual values. For example,
if the History Table is reading 0.33 in a certain RPM and TPS cell, then the ECM is adding 33% more fuel
to that area.
In order to use the history tables within TunerPro RT, a datalog file needs to be opened with TunerPro
RT. In order to determine whether the ECM has added or subtracted fuel, the ADX files’ RPM and TPS
values need to match the RPM and TPS values exactly within the BIN file. Below is how to change the
ADX files’ RPM and TPS values.
1. If TunerPro RT is not open, open up the program.
2. Load the correct ADX file (Xoptiinside’s ADX file preferably) for your ECM Firmware.
3. Load the datalog file into TunerPro by clicking from the drop-down menu Acquisition -> Load
Log File.
a. A window will appear asking to select a log file. Select the log file that has been
recorded and saved then click the OK button at the bottom of the pop-up window to
load it into TunerPro RT.
4. Click on in the top-center of TunerPro RT the “Show Data History Tables” button. This function
can also be accessed by clicking “Acquisition” from the drop-down menu, then selecting “Show
History Tables” (second from bottom of list). A table will display in the main area of TunerPro
RT, which will look somewhat like Figure 11 below:
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Figure 11: History Tables Window

NOTE: In order for the TunerPro RT History Tables function to work with your ECM, the RPM and TPS
values have to be matching (The TPS values in the far-left column and the RPM values in the top row)
between the BIN file and the ADX file. The ADX file is the only one that has the ability to change the RPM
and TPS values.

5. To edit the ADX file, select “Acquisition” from the drop-down menu at the top of TunerPro RT.
a. Select “Edit Definition”, which will display a pop-up window.
b. Click on the little plus sign (+) next to History Tables in the far left column. This will
display two sub-categories below History Tables: “Front Accel Correction vs. RPM vs.
TPS” and “Rear Accel Correction vs. RPM”. The Front section corresponds to the front
cylinder fuel table and the Rear section corresponds to the rear cylinder fuel table.
6. Select “Front Accel Correction vs. RPM vs. TPS” from the sub-category menu on the left-hand
side. The window will change to a screen like in Figure 12 below:
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Figure 12: Edit Definition File History Tables

7. Along the bottom of the window there are 3 tabs: General, Rows (Y Axis), and Columns (X Axis).
a. Select the Rows (Y Axis) tab. The window will change to a screen like Figure 13 below:

Page 19 of 41

CAUTION – By following this guide, you assume all risk of damage to yourself, your property, or your motorcycle. In
no way am I, Jared Zuech, responsible if any damage should occur.

Figure 13: Edit Definition History Tables Y Axis TPS

b. The Y Axis holds the TPS values. Click on each cell under the Label column here and
change the TPS values to match the TPS values within your ECMs BIN file. The TPS values
should be the same between this window and your BIN file. The scroll block on the side
of the table can aid in selecting the next cell value to change.
c. Now select the Columns (X Axis) tab at the bottom of the window. This will bring up a
screen similar to Figure 14 below:
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Figure 14: Edit Definition History Tables X Axis RPM

d. Repeat the same process as in the previous step (step 7c), only change these values in
the Label row to match the RPM values within your BIN file. The scroll block below the
table can aid in selecting the next cell value to change. The RPM values within the ADX
file should now match your BIN file.
8. Repeat the same process as the previous step (all of Step 7), first selecting the “Rear Accel
Correction vs. RPM” subcategory under History Tables on the left-hand side of the window.
9. Once both the rows and columns in both the front and rear accel correction subcategories have
been changed to match the values corresponding with your BIN file, click the “Save As” button
on the bottom of the window.
NOTE: Rather than clicking the “Save” button, clicking “Save As” will allow you to revert to the
unchanged ADX file if something goes wrong.
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10. When the changes to the ADX file have been saved as a different file, the pop-up window can be
closed. The RPM and TPS values on the History Table will now reflect the same RPM and TPS
values as your BIN file.
11. The History Table can now be used to determine whether the ECM has been adding fuel (engine
is running lean) or taking away fuel (engine is running rich). The option “History Average” from
the View drop-down menu at the top of the History Tables window is the best option for
relevant information (Reference Figure 11 if unsure about the drop-down menu location).
NOTE: Another way to visualize the amount of fuel that the ECM is adding or subtracting to the base
maps is to check the box titled “Graph” at the top of the History Tables window. This will transform the
spreadsheet to a grid-like graph. To revert back to the spreadsheet, simply un-check the box titled
“Graph”.

Differences between Reading From and Writing To
the ECM
NOTE: In order to either Read From or Write To the ECM, the laptop and Buell ECM have to be linked
together via the ECM transfer cable. The bike also has to have the key on and the ignition switch in the
ON position.

Both the “Upload Current Bin to Emulator” (up arrow) and the “Download Bin from Emulator to
TunerPro” (down arrow) buttons are used for Reading from and Writing to the ECM. These are the two
blue up and down arrows at the top of TunerPro RT. If the location of the 2 arrows is not clear, see
Figure 2, icon number 5. A good way to remember the two buttons is that the “up” arrow uploads to the
ECM and the “down” arrow downloads from the ECM.

Reading from the ECM
The blue down arrow at the top of TunerPro RT is the “Download Bin from Emulator to TunerPro”
button. This means that the BIN file on the ECM will be downloaded to TunerPro RT. This will take all of
the fuel tables, ignition tables, AFV and EGO correction values, etc. and transfer them to TunerPro RT.
Once the downloading bar at the bottom of the screen goes from “Downloading…” to “Complete”, the
BIN is downloaded to TunerPro RT. But, the information is not saved on the laptop and has to be saved
manually using the “Save Bin As” function under the “File” drop-down menu.
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NOTE: From Mike Cobb’s “Using TunerPro RT” PDF guide: “Once the BIN file has been downloaded, click
“File” from the drop-down menu at the top of TunerPro RT and select “Save Bin As”. This will bring up a
pop-up window for you to save the BIN file. Save the BIN file as “anyname_stock.bin”, then save it once
again in a different place titled “stockecm_1.bin”. This will allow you to have 2 copies in case anything
goes wrong.
By adding a _1 to each new saved version of the BIN folder, it will make locating and distinguishing
between BIN file easier in the future. For example: the next BIN file that had changes made to it would
be called “stockecm_2.bin”. This way you can revert back to a previous version if the current BIN file you
are working on is corrupted” (p. 7).

Writing to the ECM
The blue up arrow at the top of TunerPro RT is the “Upload Current Bin to Emulator” button. This means
that the BIN file will be burned to the ECM. Whenever the bike is turned on, the ECM will now reference
the new BIN files that were burned to it.
NOTE: Whenever writing to the ECM, make sure that the Firmware of the BIN file matches EXACTLY the
firmware version of the Buell ECM. Again, make sure that the Firmware of the BIN file matches 100% the
Firmware version of the Buell ECM. If the BIN files Firmware does not match the Buell ECM Firmware
then revert to a BIN file that does match the Firmware of the Buell ECM and start over.
If the BIN files Firmware does not match the Buell ECM Firmware type and the BIN file is uploaded to the
ECM anyway, then the ECM is now damaged. Again, make sure that the Firmware of the BIN file
matches 100% the Firmware version of the Buell ECM.

Changing BIN Table and Function Values with
TunerPro RT
NOTE: THE TOTAL NUMBER OF ROWS AND THE TOTAL NUMBER OF COLUMNS WITHIN EACH TABLE AND
FUNCTION HAVE TO REMAIN THE SAME. THERE CANNOT BE MORE OR LESS ROWS OR COLUMNS
WITHIN THESE PARAMETERS. THE TOTAL AMOUNT OF ROWS AND THE TOTAL AMOUNT OF COLUMNS
HAVE TO REMAIN THE SAME WITHIN EACH TABLE AND FUNCTION.
This section will show what tables and functions are within Xoptiinside’s Lite XDF files. These are highly
recommended over the regular XDF file since only the relevant information for tuning a Buell ECM is in
the Lite version. This section will also deal with changing the different subcategories under the “Tables”
and “Functions” headings on the left-hand side of TunerPro RT in the Parameter Tree box. They will look
something like Figure 15 below:
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Figure 15: Parameter Tree Tables and Functions Subcategories

Most of these Tables and Functions are self-explanatory. If the Table or Function seems unclear though,
you can right-click on the Table or Function and select “Edit Parameter XDF Info” from the list. This will
display a pop-up window afterwards that will have a “Description” section. In this “Description” section,
the process of the Table or Function is explained in easier terms.
In order to change the cells within the tables, open up the desired subcategory. This will display the
table in the center of TunerPro RT. To change a value in a cell, simply click within the cell and type the
new value in. The whole table can also be copied to a spreadsheet program, edited, and then pasted
back into the table in TunerPro RT. The next section is critical to saving the changes made to the BIN
tables.
NOTE: ONLY MAKE A FEW CHANGES AT A TIME. WHENEVER A CELL VALUE IS ALTERED, MAKE SURE TO
CLICK OUT OUF THE CELL. WHEN THE CELL NUMBERS TURN RED, THEN THE CHANGES HAVE BEEN
APPLIED TO THE TABLE. AFTER ALL CHANGES HAVE BEEN MADE, SAVE THE MAP TO TUNERPRO BY
CLICKING ON THE SAVE ICON (FLOPPY DISK) TO SAVE THE TABLE TO TUNERPRO. THEN UPLOAD THE FILE
TO THE ECM, MAKING SURE THAT THE HARDWARE NUMBER IS THE SAME AS THE STOCK FILE THAT WAS
ORIGINALLY FETCHED FROM THE BIKE.
A GOOD WAY TO MAKE SURE THAT THE CHANGES TOOK TO THE ECM AFTER BEING BURNED TO THE
BIKE IS TO FETCH THE DATA AGAIN AND VERIFY THE CHANGES.

Flags and Scalars within BIN files
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The Flags and Scalars categories in the Parameter Tree window are also editable within TunerPro RT.
The Scalars can be changed by clicking on the subcategory which will display a pop-up window. To
change the value, you can either click on the value and enter a new value or use the slider bar to change
the value up or down. By clicking the save button (floppy disk) within the window, you only save the
changes to the BIN file within TunerPro RT. This will not save the changes to the ECM or the file within
the Documents folder.
The Flags can be toggled on or off by clicking on the desired subcategory which will display a pop-up
window. To toggle the function on or off, click on the box. If the box is empty, the function is off. If the
box is checked, the function is on.
NOTE: By clicking the save button (floppy disk) within the window, you only save the changes to the BIN
file within TunerPro RT. This will not save the changes to the ECM or the file within the Documents
folder.

Information on Saving Changes to BIN Table Files
In order to save the value entered into a cell, you have to click out of the cell itself. If a new value has
been entered into a cell and then clicked out of (saved), the new value will appear in red. Again, the
value needs to be in red to know it is saved.
From Xoptiinside’s “Using TunerPro RT” PDF guide: “Clicking on the ‘save’ (floppy disk) icon within the
table window will only save the changes made to the file within TunerPro RT, not in the ECM or in the
BIN file saved in the documents folder.
Once all of the changes are made and saved to the file in the program, click ‘File’ from the drop-down
menu at the top of TunerPro RT and click ‘Save As’. Save the file with a chosen name and a new
number” (7).
NOTE: Again, clicking the Save BIN (floppy disk) button will only save the changes made to the BIN file to
TunerPro RT. THIS WILL NOT SAVE THE CHANGES TO THE ECM OR TO THE DOCUMENTS FOLDER. THIS
APPLIES TO THE TABLES, FUNCTIONS, SCALARS, AND FLAGS CATEGORIES IN THE PARAMETER TREE
WINDOW AT THE LEFT OF TUNERPRO RT.

NOTE: THE TOTAL NUMBER OF ROWS AND THE TOTAL NUMBER OF COLUMNS WITHIN EACH TABLE AND
FUNCTION HAVE TO REMAIN THE SAME. THERE CANNOT BE MORE OR LESS ROWS OR COLUMNS
WITHIN THESE PARAMETERS. THE TOTAL AMOUNT OF ROWS AND THE TOTAL AMOUNT OF COLUMNS
HAVE TO REMAIN THE SAME WITHIN EACH TABLE AND FUNCTION.
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Other Programs to Maximize Performance of the
Buell ECM
The sections below cover programs that are very useful in getting the best map for your Buell.

TunerPro RT MSQ Fuel Map Maker for MegaLog Viewer
This program can be found at http://www.xoptiinside.com/tuning_programs__xdf_-_adx__other_files.
This program is called “TunerPro RT MSQ Fuel Map Maker for MegaLog Viewer”. The download link for
the program is about halfway down the web page under the yellow heading of the program title. Once
downloaded, the folder should be in a “zipped” form. Once the folder is “unzipped” or “extracted,”
there will be a program file called “XPRFuelMapExtractor.” This is the actual program you will use.
The XPR Fuel Map Extractor is another useful tool for visualizing the fuel and ignition tables based on
color. The higher the amount of fuel or ignition timing, the closer the color is to red. The lower amount
of fuel or ignition timing, the more neutral the color, like light blue or light green. There is also a
function to export the tables to MegaLog Viewer by using the “MSQ Export” button. There are 4 tabs in
the middle-left of the program. They are (from left to right): Fuel Map Front, Fuel Map Rear, Timing Map
Front, and Timing Map Rear. These correspond to each of the tables in the BIN file of the ECM.
Once the program is opened, it will look like Figure 16 below:
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Figure 16: XPR Fuel Map Extractor
Whenever you use this program, you need the XDF and the BIN files for your Buell ECM.
1. Click on the top-left box titled “XDF File (Template Definition)”. This will bring up a pop-up
window where you select the XDF file.
NOTE: The XDF file has to be a version that is recognizable by the program. The XDF file cannot be the
V5 (Version 5) or the Lite XDF file. For a complete download of all XDF files, visit this site at
http://www.xoptiinside.com/tuning_programs__xdf_-_adx__other_files and scroll down to an orange
link titled “TunerPro RT XDF Files Full Set Zip Files.” Click this link, which will be a “zipped” file, then
“unzip” or “extract” the files. The correct XDF files to be used with this program are just the Hardware
name with no V5 or Lite afterwards.

2. Click on the second box down on the left-hand side titled “XPR File (EPROM Binary Data)”. This
will bring up a pop-up window where you select the appropriate BIN file.
NOTE: XPR and BIN files (.xpr and .bin files, respectively) are essentially the same thing. Where this says
to load XPR file, just load the appropriate BIN file. However, DO NOT change a BIN file to an XPR file
extension. For instance, do not change a “stockecm_1.bin” file to “stockecm_1.xpr” file. If it is loaded to
the ECM, the ECM will be damaged.
If the correct XDF file has been used, you should see a colored map appear in the big box in the center of
the XPR Fuel Map Extractor. Figure 17 is what the program should look like after the BIN file has been
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loaded (The numbers and colors may or may not be the same, being that there are differences between
each BIN file used for different models and years of Buell motorcycles).

Figure 17: XPR Fuel Map Extractor Example

Column and Row Calculator
This program can be found at:
http://www.xoptiinside.com/engine_tuning_guide_with_column_and_row_calculator. This program is
called “Column and Row Calculator”. The Column and Row Calculator is a spreadsheet in Microsoft
Excel. The Column and Row Calculator is used for approximating fuel values based on the left and righthand RPMs, the TPS, and the current fuel values. This will make more sense as the program is described
later on.
The Column and Row Calculator program is used for filling in the gaps between RPM and TPS values. This
will give the ECM a better resolution, allowing for more precise fuel delivery and ignition timing. This
translates to better performance of the motorcycle.
To download the Column and Row Calculator Excel spreadsheet:
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1. Click on the link mentioned before in this section. Midway down the page is a white
spreadsheet, which looks like Figure 18 below:

Figure 18: Column and Row Calculator Column Sheet

2. Click on the spreadsheet on the website. A pop-up window will appear asking if you would like
to open with Microsoft Excel. Microsoft Excel is the easiest to work with since it was created
within Excel, but the program can be opened and used in other spreadsheet programs.
NOTE: If the Column and Row Calculator is opened with Libre Calc, the document will be in read-only
mode. This will need to be changed within Libre Calc and will not be covered in this document.
3. The program has two different sections: Columns and Rows. When the program is opened up,
the Column Sheet section appears. The Row side can be switched over to by clicking the “Row
Sheet” tab at the bottom-left of the spreadsheet.

Column Section
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Referencing Figure 17, the Column section is divided up into 4 columns. The top of the program
has headings such as “Left side of Desired RPM”, “Desired RPM”, and “Right side of Desired
RPM”. Just below the heading is a row where you can enter the various RPM information. The
far-left column is where you enter the TPS values that are in the fuel table. These RPM and TPS
values can be changed based on the changes you want to make to the fuel map.
For example, by looking at Figure 17, you can see that there is a 0 RPM column. This is not helping the
ECM at all, since the engine is not running at 0 RPM and is a waste of a column. If you would like to
move that column around within the fuel table, but do not know what to put as the amount of fuel
based on a given the TPS and RPM, this program will become very useful. For instance, if your bike
spends most of its time cruising at around 3200 RPM, but the ECM only shows RPMs of 2900 and 3400,
then that 0 RPM column can be cut and pasted between the 2900 and 3400 RPM range for a 3200 RPM
column. These RPM values would go in the respective left and right side of desired RPM section (Where
the red numbers are in Figure 17). The TPS values of the ECM would go in the far-right column of the
program, like in Figure 19 below:

Figure 19: 3200 RPM Example

The “Actual Median Fuel Value” will change depending on the data entered, which will be between the
fuel numbers on the left and right side, if the data was entered correctly.

NOTE: The process of moving fuel table columns around will be discussed in more detail in the section
titled “Changing Bin Table Values with TunerPro RT”.

When the 0 RPM column is moved between the 2900 RPM and 3400 RPM column, the “Actual Median
Fuel Value” fuel numbers is what will be entered corresponding with the TPS value in the far-left
column.
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NOTE: These fuel numbers may or may not match your ECM. This fuel table was only used as a
reference. The fuel numbers might be slightly rich or lean, based on the bike and the ECM. Data
Acquisition can help fine tune these numbers to yield the best performance.

As you can see in Figure 18, the program will not let you input a number over 255 for the fuel. If a
number greater than 255 is entered, a pop-up window will appear saying that a number has been
entered above the cell range. This limits you from making a mistake in the program that could cause
problems with the BIN file down the road.

Row Section
To access the Row Section of the Column and Row Calculator program, click on the tab in the lower-left
of the spreadsheet that says “Row Sheet”. The spreadsheet should look like Figure 20 below:

Figure 20: Column and Row Calculator Row Sheet

The Row Sheet performs the same function as the Column Sheet, just in a different orientation. Instead
of having columns to enter data, there are rows. Also, instead of creating an RPM value between an
upper and lower RPM value, it is TPS values. The Row Sheet can also be used for estimating Ignition
Timing values, just like fuel values. An example like one that was used for the Column Sheet section will
be demonstrated with the Row Sheet later on.
1. The 3 khaki colored cells are used for entering the appropriate TPS data, such as Upper TPS,
Lower TPS, and Desired TPS. The very bottom row is for entering RPM data, which does not
factor into the fuel value calculations. The RPM row is merely there for your own reference.
2. The first and third rows down with blue cells are for the fuel data. These are the fuel numbers
that correspond to the TPS values within the BIN file.
3. The second row down with the white cells are what the spreadsheet will calculate as the
fuel/ignition values based on the current TPS and fuel/ignition values in the stock BIN file. The
white cell values will change whenever the TPS or fuel/ignition values are changed in the khaki
and blue cells.
For example, Referencing Figure 17, there are TPS values of 60 and 80. If I wanted to move the 40 TPS
row between the 60 and 80 and change the 40 to a 70, then the Row Sheet is the program of choice.
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Referencing Figure 12 again, the upper and lower fuel numbers of TPS value 80 and 60 respectively, are
entered into the program. The corresponding RPM values are also entered for referencing, but are not
factored into the fuel/ignition calculations. See Figure 21 below:

Figure 21: Column and Row Calculator Row Sheet Example

Referencing Figure 17, if you wanted to move the 40 TPS row between the 60 and 80 TPS row to create
a 70 TPS row, then the calculated fuel numbers would be entered into the BIN file. These fuel numbers
might be a little rich or lean, but data acquisition can help to improve these values.

Troubleshooting Various Problems Associated
with TunerPro RT
This section will discuss various ways to solve some common problems that show up with tuning the
Buell ECM.

Dropped Connection with Data Acquisition
If there is a problem during data acquisition, the Data Acquisition Status bar at the bottom of TunerPro
RT will either stay pink saying “Connecting…” or flash alternately between blue and red. This problem
can occur when either trying to connect the laptop and ECM with the ADX file or during actual
datalogging. Figure 22 below describes how to fix the data acquisition problem.
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Figure 22: Data Acquisition Connection Problems Solution (Xoptiinside)

The payload and body size can be edited by clicking on the “Acquisition” drop-down menu at the top of
TunerPro RT, and then selecting “Edit Definition File”. The payload and body size can be edited by
expanding the “Commands” category on the left-hand side of the window and is most commonly under
the “Retrieve Live Data” subcategory.

Smoothing Extraneous Values within BIN tables
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Extraneous values are numbers that do not fit in with the other numbers around it. For example, take a
look at Figure 23 below. At 3400 RPM and 60 TPS, the fuel value is 110. But, the immediate surrounding
numbers are 112, 97, 97, 140, 175, 150, 130, and 120.

Figure 23: Extraneous Value Example

These numbers are all within proximity, but that large gap between those proximity values will be felt
during riding. In order to make the bike more street friendly, we need to make those numbers have a
not so big of a difference between them. This is a technique called smoothing. Figure 24 below shows
this technique utilized on the abrupt changing fuel table in Figure 23.

Figure 24: Fuel Table Smoothing the Extraneous Value
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The changes are not as abrupt now that we have smoothed the values around the 3400 RPM and 60
TPS. This will translate to a smoother transition when riding the motorcycle. The best program to use for
smoothing these values is the Column and Row Calculator. This will take the guess work out of trying to
decide on what values to change. Of course, you need to know what values to change based on the
History Average table within the “History Tables” function.
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Appendix
Glossary
ECM – ECM is an abbreviation for Electronic Control Module. This is the computer on the motorcycle
that controls all of the engine functions, from how much fuel the engine receives to how long the fan
stays on after the bike is shut off.
XDF – This file is an index of the ECM. The XDF file is used for sending and downloading files to and from
the ECM.
ADX – This file is an index of the live data within the ECM. The ADX file is used for seeing the data that
the ECM is seeing in real time.
BIN – This file is where all of the tables, functions, and scalars of the ECM are held. All of the tables,
functions, and scalars can be changed with TunerPro RT.
RPM – RPM is an abbreviation for Revolutions Per Minute. This is how many times the engine will
complete a full rotation in one minute.
TPS – TPS is an abbreviation for Throttle Position Sensor. The sensor determines the amount that the
throttle is opened or closed and sends that signal to the ECM.
AFV – AFV is an abbreviation for Adaptive Fuel Value. This value is constantly changing by the inputs
being received by the ECM. This is the function that will never allow the motorcycle to run lean.
IAT – IAT is an abbreviation for Inlet Air Temperature. This sensor will determine the temperature of the
air entering the engine. The signal it generates is sent to the ECM for table referencing.
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